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Abstract

Cerebrospinal fluid (CSF) flow in rodents has largely been studied using ex vivo quantification of 

tracers. Techniques such as two-photon microscopy and magnetic resonance imaging (MRI) have 

enabled in vivo quantification of CSF flow but they are limited by reduced imaging volumes and 

low spatial resolution, respectively. Recent work has found that CSF enters the brain parenchyma 

through a network of perivascular spaces surrounding the pial and penetrating arteries of the 

rodent cortex. This perivascular entry of CSF is a primary driver of the glymphatic system, a 

pathway implicated in the clearance of toxic metabolic solutes (e.g., amyloid-β). Here, we 

illustrate a new macroscopic imaging technique that allows real-time, mesoscopic imaging of 

fluorescent CSF tracers through the intact skull of live mice. This minimally-invasive method 

facilitates a multitude of experimental designs and enables single or repeated testing of CSF 

dynamics. Macroscopes have high spatial and temporal resolution and their large gantry and 

working distance allow for imaging while performing tasks on behavioral devices. This imaging 

approach has been validated using two-photon imaging and fluorescence measurements obtained 

from this technique strongly correlate with ex vivo fluorescence and quantification of radio-

labeled tracers. In this protocol, we describe how transcranial macroscopic imaging can be used to 

evaluate glymphatic transport in live mice, offering an accessible alternative to more costly 

imaging modalities.

SHORT ABSTRACT

Transcranial optical imaging allows wide-field imaging of cerebrospinal fluid transport in the 

cortex of live mice through an intact skull.
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INTRODUCTION

Cerebrospinal fluid (CSF) bathes the brain and spinal cord and is involved in maintaining 

homeostasis, supplying nutrients, and regulating intracranial pressure1. CSF in the 

subarachnoid space enters the brain through a network of perivascular spaces (PVS) 

surrounding cortical pial arteries and then flows down along penetrating arterioles2. Once in 

the parenchyma, CSF exchanges with interstitial fluid (ISF), carrying harmful metabolites 

such as amyloid-β (Aβ) and tau protein aggregates out of the brain through low resistance 

white matter tracts and perivenous spaces2,3. This pathway is dependent on astroglial 

aquaporin-4 (AQP4) channels and has therefore been termed the glial-lymphatic 

(glymphatic) system4. Waste products of the neuropil are ultimately cleared from the CSF-

ISF through lymphatic vessels near cranial nerves and in the meninges out towards the 

cervical lymph nodes5. The failure of this system has been implicated in several neurologic 

diseases such as Alzheimer’s disease6,7, traumatic brain injury3, and ischemic and 

hemorrhagic stroke8.

CSF transport can be visualized by infusing tracers into the cisterna magna (CM)9,10 and 

glymphatic studies in the past have mainly utilized two-photon microscopy4,11–13, magnetic 

resonance imaging (MRI)14–17, and ex vivo imaging3,6,11,18 to evaluate tracer kinetics. Two-

photon microscopy is a suitable method for detailed imaging of CSF tracers in PVSs and the 

parenchyma due to its high spatial resolution, however, it has a narrow field of view and 

requires an invasive cranial window or thinning of the skull. Ex vivo imaging, in 

combination with immunohistochemistry, enables multilevel analyses ranging from single 

cells up to the whole brain19. However, the process of perfusion-fixation that is required to 

observe the post-mortem tissue produces profound changes in CSF flow direction and 

collapses the PVS, significantly altering the distribution and the location of the tracers12. 

Finally, while MRI can track CSF flow throughout the entire murine and human brain, it 

lacks spatial and temporal resolution of perivascular flow.

A new technique, transcranial macroscopic imaging, solves some of these limitations by 

enabling wide-field imaging of perivascular CSF transport in the entire dorsal cortex of 

living mice. This type of imaging is done with an epifluorescent macroscope using a 

multiband filter cube, tunable LED light source, and high-efficiency CMOS camera10. These 

set-ups are able to resolve PVSs up to 1–2 mm below the skull surface and can detect 

fluorophores up to 5–6 mm below the cortical surface while leaving the skull entirely 

intact10. Multiband filters and LEDs that can quickly tune the excitation wavelength enable 

the use of multiple fluorophores allowing CSF to be labeled with tracers of different 

molecular weights and chemical properties in the same experiment.

This procedure requires a simple, minimally invasive surgery to expose the skull and place a 

light-weight head plate to stabilize the head during the imaging session. Tracers can be 

delivered into the CM without drilling into the skull or penetrating the cortical tissue with 
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pipettes or cannulas9,20. Both CM cannulas and head plates remain stable for several days to 

weeks and facilitate more complex experimental designs compared to the classical end-point 

visualization. This protocol describes how transcranial macroscopic imaging is used to study 

glymphatic system function following acute or chronic injection of fluorescent CSF tracer 

into the CM of anesthetized/sleeping or awake mice.

PROTOCOL

All experiments were approved by the University Committee on Animal Resources (UCAR, 

Protocol No. 2011–023) at the University of Rochester and performed according to the NIH 

Guide for the Care and Use of Laboratory Animals.

1. Preparing the cisterna magna cannula, head plate, and head holder

Sterilize all surgical instruments and head plates before surgery.

NOTE: Fluorescent tracers are delivered directly into CSF via a cisterna magna cannulation. 

For detailed instructions on this procedure, please refer to Xavier et al9.

Briefly, using a needle driver, break the tip of a 30G x 12.7 mm (½ inch) needle, ¾ of the 

way down, and place the blunt end of the needle into one end of polyethylene 10 (PE10) 

tubing (about 45 cm long). Make sure that only the bevel is protruding out of the border of 

the PE10 tubing.

Break off ¼ of the beveled end of another 30G needle and place the blunt end of the 

remaining needle into the other end of the PE10 tubing, with the plastic Luer-lock still 

attached.

Fill a 100 μL glass syringe with sterile, artificial CSF (aCSF: 126 mM NaCl, 2.5 mM KCl, 

1.25 mM NaH2PO4, 2 mM MgSO4, 2 mM CaCl2, 10 mM glucose, and 26 mM NaHCO3).

Attach the syringe to the end of the line and fill it with aCSF until it reaches the tip of the 

beveled needle. It is important that the syringe is backfilled with aCSF and not air, as an air 

column is more prone to variable infusion volumes.

For chronic experiments, leave the line filled with aCSF and skip Step 1.7.

For acute experiments, place the syringe on an infusion pump and withdraw approximately 5 

mm of air, which will prevent mixing. Afterwards, withdraw the total volume of tracer(s) 

that is desired for the experiment (20% extra is recommended due to dead space losses).

NOTE: The PE10 tubing should be long enough so that the air bubble does not enter the 

plastic cuff of the glass syringe when loading the tracer. For a typical experiment, the 

protocol uses 10 μL of bovine serum albumin conjugated to Alexa Fluor 647 (BSA-647) 

diluted in aCSF at 0.5%.
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Confirm that the head plate fits into the head holder and that it is the right size for the mouse 

being used. Anatomical markers to ensure this are: the top border of the window aligns with 

the interocular line and the posterior border falls rostral to the occipital crest.

NOTE: Stainless-steel head plates can be sterilized and reused. Most cyanoacrylate mixtures 

can be removed with an acetone solution.

2. Surgical procedure

Weigh and anesthetize the mouse (e.g. ketamine/xylazine; 100 mg/kg ketamine, 10 mg/kg 

xylazine; i.p.).

Once the mouse no longer responds to a toe pinch, moisten the neck and head with sterile 

water and shave using clippers. Once the area is shaved, wipe the area with an alcohol swab 

again to remove any residual hair.

NOTE: Moistening the fur before clipping dramatically reduces the amount of hair in the 

imaging window after the incision.

Place the mouse in a stereotactic frame on top of a temperature-controlled pad and apply 

petroleum ophthalmic ointment to the mouse’s eyes to ensure they do not dry out.

Clean the exposed skin with a chlorhexidine swab. After 2 min, remove the chlorhexidine 

with an alcohol wipe. Finally, apply an iodine solution which can be left to dry.

Apply topical analgesia (0.25% Bupivacaine HCl) to the top of the skull and the neck.

Starting on the part of the neck that covers the occipital crest, make a midline cut in the 

overlying skin and continue rostrally towards the interorbital line. Incise laterally to the 

border where the temporal muscle inserts into the skull. Remove all of the skin of the 

fusiform incision to expose both the frontal and parietal bones.

CAUTION: The retroorbital sinus lies caudal to the eyes and large branches of the posterior 

facial vein lie rostral to the pinna. Be careful when making the incision to spare these 

structures. If this occurs, stop bleeding by maintaining hemostasis with a sterile cotton swab 

for several minutes and continue.

Irrigate the skull with sterile saline and clean the surface using cotton swabs so that it is free 

of debris and hair since these will interfere with the image quality. Skull transparency is best 

preserved by leaving the periosteum and overlying fascia intact.

NOTE: If these structures are accidentally removed, the skull can become dry and opaque 

over time. Re-moisten with aCSF or use a mixture of paraffin oil and glycerol to reduce 

skull reflectance in acute experiments21.

Proceed to inserting the cisterna magna cannula - for surgical details of this procedure, refer 

to Xavier et al9.
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After inserting the CM cannula, apply a mixture of dental cement with cyanoacrylate glue to 

the ventral side of the head plate around the border and place it on the skull so that the 

anterior border of the head plate aligns with the posterior tip of the nasal bone and the 

posterior border aligns with the anterior aspect of the interparietal bone, making sure that the 

sagittal suture (midline) is centered and straight relative to the window (Figure 1B).

Fix the position of the head plate using a couple drops of glue accelerator. Fill any remaining 

gaps with the cement mixture and cure it with accelerator.

CAUTION: Make sure the cyanoacrylate does not come in contact with the mouse’s eyes or 

block the imaging window.

Glue the CM cannula to the head plate to ensure that these do not become detached during 

transport or when the mouse wakes up.

For acute experiments, skip to Step 2.16.

For chronic experiments, apply a thin layer of clear-drying cyanoacrylate glue to the exposed 

skull, being careful not to create bubbles as these will interfere with the imaging. The glue 

provides protection for the skull and will not interfere with the imaging. Make sure that the 

glue covers the exposed skull all the way to the skin at the incision border.

Use a hemostat clamp to hold the aCSF-filled PE10 tubing 2–3 cm from the CM and cut the 

line with a high-temperature cautery tip. Once it is separated, flatten the melted PE10 tubing 

to seal the cannula.

CAUTION: Make sure not to release the clamp until after the cannula has been sealed and 

confirm there are no leaks in the tubing to prevent a CSF fistula.

Administer carprofen (5 mg/kg every 24 h for 3 days; i.p. or s.c.) and return the mouse to a 

temperature-controlled, single-housed cage and allow it to recover for at least 24 h prior to 

imaging. Do not leave the mouse unattended until it regains sufficient consciousness to 

maintain sternal recumbency. Intact cranial windows remain stable for several weeks.

NOTE: The chronic experiment can be paused here.

CAUTION: Some postoperative complications are: cephalohematoma/subgaleal hematomas, 

CSF fistula, and infection.

For acute experiments, place the mouse into the head holder using the head plate so the skull 

is in a fixed position. Make sure to check anesthesia level and place a heating pad under the 

mouse. The mouse is now ready to be taken to the macroscope.

CAUTION: Carefully transport the mouse together with the infusion pump on a cart. If the 

CM cannulation becomes dislodged, it will cause a drop in intracranial pressure and any 

CSF leaks will alter the experimental results.
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3. Preparing the mouse for imaging

NOTE: The protocol varies depending on whether the imaging experiment will be performed 

on an anesthetized (start at Step 3.1) or awake (start at Step 3.2) mouse.

Anesthetized Mice

Place the head holder on the stage of the macroscope, making sure there are no kinks in the 

line from the syringe pump to the CM cannula and that it is not taut since this could affect 

the tracer infusion.

Observe respiratory rate and pink coloration of the mucous membranes, indicating good 

oxygenation. Inject saline subcutaneously to secure hydration level if necessary. Check to 

make sure the animal is sufficiently anesthetized and re-dose if needed.

Turn on the macroscope camera and LED and start LIVE mode.

Confirm the magnification of the imaging field so that the nasofrontal suture at the top of the 

field and the lambdoid suture at the bottom can clearly be visualized, with the sagittal suture 

parallel and centered to the middle of the image (Figure 1C). Once in place, secure the head 

holder to the macroscope stage with tape.

Focus the macroscope on the exposed skull. Despite macroscopes having a relatively large 

depth of field, the curvature of the mouse’s skull only allows for a specific area to be in 

focus. Best results are obtained when the focal plane is located on the lateral sides of the 

parietal bones posterior to the coronal sutures.

NOTE: This is the location of the middle cerebral arteries (MCA), where most CSF inflow 

occurs (Figure 1D,E)10.

Awake Mice

Prior to the imaging session, let the animals recover for at least 24 h from the head plate 

surgery. Longer recovery periods (5–7 days) are also recommended. During this time, train 

the mouse to be head fixed on the stage in the restraint tube for 0.5–1 h per day for the 

duration of the recovery period.

NOTE: Habituation allows the mouse to be attached to the head holder without anesthesia 

and reduces stress and anxiety during the actual experiment. If this is not feasible and 

anesthesia does not interfere with the experiment, an induction dose of an inhaled anesthetic 

(e.g., isoflurane 2% at 1–2 L/min O2 flow rate) can be used to quickly attach the mouse to 

the head stage.

Once the mouse is fixed to the head holder and in the restraint tube, follow Steps 3.1.1–

3.1.5.

Sweeney et al. Page 6

J Vis Exp. Author manuscript; available in PMC 2020 February 05.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



4. Infusion of fluorescent CSF tracers

4.1. Acute CM Cannulation

Since the tracer was already loaded into the cannula before being placed in the cisterna 

magna in Step 1.6, set the infusion pump to the desired rate and volume. Infusion paradigms 

routinely used are 5–10 μL at 1–2 μL/min, but these parameters can be adjusted depending 

on the particular experiment, or the size and age of the animal.

4.2. Chronic CM Cannulation

Prior to beginning the imaging session, follow Steps 1.2–1.7 for acute experiments to 

prepare the infusion line to deliver the tracers.

Once the line is prepared, using a hemostat clamp cut the sealed end of the chronic CM 

cannula. Take the needle from the line prepared in Step 4.2.1 and gently insert it into the 

cannula. Release the clamp and using the syringe pump, advance the CSF tracer at the 

desired infusion rate (e.g., 2 μL/min) for the experiment until the tracer reaches the 

implanted needle in the CM.

CAUTION: If the needle pierces through the tubing when connecting the line, remove the 

needle, cut the pierced segment and repeat this step. Any tear in the PE10 tubing will cause a 

leak and affect the results of the experiment.

5. Setting up the Imaging Session

Based on the fluorescent tracer being infused, determine the excitation wavelength and the 

exposure time for each channel. Choose the shortest exposure time necessary to visualize the 

tracer in order to maximize the temporal resolution of the time-lapse imaging. This exposure 

time will be used for all subsequent experiments aiming to compare CSF transport between 

different animals.

NOTE: One tip is to use the tracer in the CM line to adjust the exposure time. Although this 

is a useful first approach, this should be optimized over time.

Choose the duration of the experiment and the intervals at which the images will be 

acquired. Experiments normally last between 30–60 min depending on what phase of 

glymphatic transport is of interest. Frame rates of 1 frame/min and faster are sufficient for 

most experiments.

Set the file name and the saving directory.

If the imaging will be collected in addition to simultaneous acquisition of other variables 

(e.g., electrocardiogram, arterial blood pressure, electrophysiology), the macroscope and 

pump can be programmed to be triggered with the data acquisition software. Check that the 

triggering function on the macroscope is correct before moving to the next step.

6. Transcranial optical imaging experiment

Start the tracer infusion and the imaging at the same time.
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Routinely check the CM cannula and the PE10 tubing for any signs of a leak. If there is any 

tracer leaking at the CM, the results from this experiment must be excluded.

NOTE: If tracer starts to accumulate in the cerebellum and does not travel the glymphatic 

pathway of the MCA, it is likely that the CM cannula was injected into the cerebellum. This 

data should not be included.

For acute experiments, after completion of the experiment, remove the mouse from the 

microscope and check that it is still adequately anesthetized. Quickly decapitate the mouse 

and harvest the brain tissue. Immersion-fix the brain in 4% paraformaldehyde (PFA) 

overnight at 4 °C.

For chronic experiments, once the imaging is completed, remove the CM line from the 

cannula, flush with sterile aCSF and reseal the CM cannula with a high-temperature cautery 

tip. Remove the mouse from the head stand and return it to its cage. Repeat this process until 

further imaging is not required and then follow Step 6.3.

7. Data analysis

NOTE: Matlab-based analyses, such as CSF front-tracking can extract large amounts of 

quantitative data from the tracer fronts in these imaging datasets10,22. However, these file 

types can also be easily imported and analyzed in open-source image analysis software like 

Fiji23.

Import the image stacks into Fiji using the Bio-Formats import tool. This function will 

preserve the file metadata which includes the time and pixel resolution. Save the image stack 

as a .tiff file.

Manually draw a region of interest (ROI) around the skull or the area of interest using the 

polygon selection tool. For example, in Figure 1G an ROI was drawn separately for the 

ipsilateral and for the contralateral hemisphere after a traumatic brain injury. Make sure to 

add the ROI into the ROI Manager (Analyze>Tools>ROI Manager) and save it.

NOTE: CSF transport can be quantified in two main ways: 1) mean fluorescence intensity 

over time or 2) influx area expressed as a percentage of the ROI or total area (mm2) after 

having applied a threshold. The latter method (Figure 1H) will be described in the next 

steps.

Set the threshold on the frame with maximal fluorescence (Select 
Image>Adjust>Threshold…). Automated threshold methods such as Otsu are normally 

good at detecting CSF tracer. Apply the threshold.

Before going forward, make sure that in Analyze>Set Measurements, the options Area and 

Area Fraction are selected. Then in the ROI Manager, select More>Multi Measure.

Convert the %Area value into mm2 using the Area value of the ROI from the output. The 

%Area values reflect the percent of the dorsal cortical surface with CSF tracer.
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Plot CSF tracer influx in mm2 as a function of time.

REPRESENTATIVE RESULTS

CSF influx is imaged on an epifluorescent macroscope (Figure 1A), which allows for 

mesoscopic imaging of CSF tracer transport in the murine cortex. The whole-skull head 

plate permits the visualization of the rostral nasal bones, both frontal and parietal bones in 

the center, and the rostral portion of the interparietal bone caudally (Figure 1B). During 

imaging, the nasofrontal, sagittal, coronal, and lambdoid sutures can be readily identified 

(Figure 1C). Once the infusion of CSF tracer into the CM begins (Figure 1D), tracer 

fluorescence is first seen in large pools of subarachnoid CSF at the basal cistern, 

olfactofrontal cistern, and the quadrigeminal cistern near the pineal recess (Figure 1E, left). 

CSF tracers then enter the brain along perivascular spaces of the cortical pial branches of the 

middle cerebral artery (MCA) (Figure 1E, right).

Transcranial optical imaging can be used to study glymphatic function after traumatic brain 

injury (TBI)3. Mice received a moderate TBI and immediately afterwards a fluorescent CSF 

tracer (BSA-647) was injected into the CM24. CSF transport was imaged for 60 min after 

TBI (Figure 1F). Macroscopic imaging shows that tracer is first seen at the olfactofrontal 

cistern but glymphatic influx along cortical PVSs is completely abolished on the side of the 

TBI (Figure 1G, Supp. Movie 1). The inhibitory effect of TBI on glymphatic function has 

been shown using several other tracer quantification methods and could underlie the 

relationship between TBI and the accumulation of Aβ and tau seen after injury3. 

Quantitative analysis of in vivo images show that ipsilateral influx area is decreased nearly a 

third compared to the contralateral hemisphere (Figure 1H).

DISCUSSION

We have described a detailed protocol for performing transcranial CSF imaging in live mice 

using commercially-available fluorescent macroscopes and tracers. This technique is simple 

and minimally-invasive, yet quantitative. In vivo imaging correlates well with sensitive 

methods such as liquid scintillation counting of radio-labeled tracers including 3H-dextran 

and 14C-inulin after CM delivery, and with ex vivo coronal section quantification10,18. 

Validation with two-photon microscopy demonstrates that CSF tracers seen along cortical 

blood vessels under the macroscope are primarily located within perivascular spaces of the 

MCA and its branches10. These CSF inflow pathways are a critical component of the 

glymphatic system19. Although not covered in this protocol, these set-ups can also be used 

to image CSF clearance pathways such as the meningeal and cervical lymphatics25,26.

Improvements in head plate design enables chronic, stable, wide-field imaging of the same 

mouse over time. Head plate shape, size, and weight can be tailored for each specific 

application. With advances in laser cutting and 3D printing, there are few limitations as to 

the specifications. Head plating also allows for longitudinal imaging of either anesthetized or 

awake animals and the ability to image through an intact skull avoids neuroinflammation 

and edema associated with the placement of cranial or thin skull windows27–29. This is an 

important advantage since stereotaxic delivery of fluorescent tracers through the cortex into 
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the striatum or lateral ventricles using a cranial burr hole greatly reduce glymphatic 

function20,26. The large gantry and working distances of most commercial macroscopes 

allow for mice to be fixed to the stage in various configurations, including running wheels or 

floating mazes. Mice can be trained and habituated to being head fixed to the microscope 

stage during the 5–7-day recovery period to facilitate awake imaging30.

One of the principal limitations of this method is the low penetration depth of the 

macroscope compared to two-photon microscopy10. This device is capable of resolving only 

a few millimeters of the cortical surface below the intact skull. However, while this limits the 

imaging of processes occurring deeper down in the tissue, it is generally not a problem for 

glymphatic analyses since the major routes of entry are primarily located around the main 

arteries of the dorsal cortical surface. Despite being unable to resolve deeper structures, 

macroscopes with high efficiency scientific CMOS cameras have great fluorescence 

detection; despite tracer not being located at the brain surface, total fluorescence intensity 

correlates with the amount of tracer found in the brain at every time point after the start of 

the CM injection10. These parameters are improved by the use of far-red, near-infrared, or 

infrared tracers since imaging at these longer wavelengths reduces tissue auto-fluorescence 

and the scattering of light, and have a superior signal-to-noise ratio than lower emission 

wavelength fluorophores. The standard macroscope enables imaging of more than one tracer 

in the same experiment. Depending of the configuration of the macroscope, the filter turret 

has to rotate between acquisitions, drastically reducing the temporal resolution that can be 

obtained. This can be improved by the use of tunable LEDs and a multiband filter cube. 

Despite this improvement, multichannel imaging is not truly simultaneous, since there is a 

delay in the acquisition while the LED switches between excitation wavelengths. It is 

possible to achieve simultaneous dual channel imaging using image splitting optics that are 

compatible with most macroscopic set-ups; however, these sacrifice spatial resolution by 

dividing the full resolution of the CMOS camera (2048 × 2048 pixel) into two fields of view 

with half the resolution (1024 × 1024 pixel). While CMOS cameras are quite adequate for 

this utilization, the use of a CCD camera can be applied to this application as well. An 

additional factor that reduces temporal resolution is the exposure time required for adequate 

excitation of the chosen fluorophore, which normally ranges between 50 – 1000 ms. This 

can be further optimized by using either 2×2 or 4×4 pixel binning, which reduces the 

exposure time and increases the frame rate, at the expense of spatial resolution. Despite 

these limitations, transcranial macroscopic multichannel imaging is capable of achieving 

frame rates between 10–20 Hz with high spatial resolution.

Recent examples in transcranial macroscopic imaging have used aquaporin-4 (AQP4) knock 

out mice10,20 and platelet-derived growth factor B (PDGF-B) retention motif knockout 

mice22 to demonstrate the importance of AQP4 and PDGF-B in the glymphatic system. The 

studies used C57Bl6 wildtype mice to compare to the knockout mouse lines. They 

transcranially imaged the mice for a duration of 30 min using fluorescent tracers and the 

results concluded that the knockout lines had dramatically reduced CSF influx compared to 

wildtypes.

These properties make transcranial optical imaging an ideal technique to study CSF 

transport, especially between 2 or more cohorts of animals. It permits measurements of 
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intracisternal tracer kinetics in live mice at a micron scale resolution, at a fraction of the cost 

of other in vivo imaging modalities. This technique allows the study of the glymphatic 

system in a physiological, non-invasive way, and has been useful in helping elucidate some 

of the factors that regulate its function in health and disease10,20,25. However, its most 

exciting attribute is its potential to answer future questions about CSF hydrodynamics.

Supplementary Material

Refer to Web version on PubMed Central for supplementary material.
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Figure 1. Transcranial macroscopic imaging.
(A) Schematic of the macroscopic imaging set up. (B) Dorsal view of the position of the 

head plate on the skull. The interparietal bone and the nasal, frontal, and parietal bones are 

all visible. (C) An exposed mouse skull during imaging before CSF tracer has appeared, 

clearly showing all cranial sutures of the intact skull. Scale bar: 1 mm (D) Schematic of a 

lateral view of CSF tracer entering the cisterna magna (CM) and traveling from the basal 

cistern along the glymphatic pathway. (E, left panel) Macroscopic imaging of glymphatic 

influx in a ketamine-xylazine anesthetized wildtype mouse at 20 minutes post CM injection 
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(BSA-647; 10 μL at 2 μL/min). CSF tracer is seen in the olfactofrontal cistern around the 

rostral rhinal vein below the nasofrontal suture, along some parts of the superior sagittal 

sinus below the sagittal suture, and in the pineal recess surrounding the transverse sinus 

below the lambdoid suture. (E, right panel) Digital magnification of the image on the left 

shows the high spatial resolution obtained with these microscopes. CSF tracer travels within 

the perivascular spaces of the middle cerebral artery (MCA)10. Scale bar: 0.5 mm (F) 

Experimental timeline. An anesthetized wildtype mouse received a moderate traumatic brain 

injury (TBI)24 and immediately after a CM injection (BSA-647; 10 μL at 2 μL/min), 

followed by 60 min of macroscopic imaging. (G) Time-lapse images of CSF tracer transport 

after TBI (dashed line). Scale bar: 1 mm (H) Influx area (mm2) over each hemisphere during 

the 60-min experiment, quantified from the ROIs in (G), the hemisphere that received TBI 

(ipsilateral) and the hemisphere that did not (contralateral).
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	Abstract
	SHORT ABSTRACT
	INTRODUCTION
	PROTOCOL
	Preparing the cisterna magna cannula, head plate, and head holder
	Sterilize all surgical instruments and head plates before surgery.NOTE: Fluorescent tracers are delivered directly into CSF via a cisterna magna cannulation. For detailed instructions on this procedure, please refer to Xavier et al9.
	Briefly, using a needle driver, break the tip of a 30G x 12.7 mm (½ inch) needle, ¾ of the way down, and place the blunt end of the needle into one end of polyethylene 10 (PE10) tubing (about 45 cm long). Make sure that only the bevel is protruding out of the border of the PE10 tubing.
	Break off ¼ of the beveled end of another 30G needle and place the blunt end of the remaining needle into the other end of the PE10 tubing, with the plastic Luer-lock still attached.
	Fill a 100 μL glass syringe with sterile, artificial CSF (aCSF: 126 mM NaCl, 2.5 mM KCl, 1.25 mM NaH2PO4, 2 mM MgSO4, 2 mM CaCl2, 10 mM glucose, and 26 mM NaHCO3).
	Attach the syringe to the end of the line and fill it with aCSF until it reaches the tip of the beveled needle. It is important that the syringe is backfilled with aCSF and not air, as an air column is more prone to variable infusion volumes.
	For chronic experiments, leave the line filled with aCSF and skip Step 1.7.
	For acute experiments, place the syringe on an infusion pump and withdraw approximately 5 mm of air, which will prevent mixing. Afterwards, withdraw the total volume of tracer(s) that is desired for the experiment (20% extra is recommended due to dead space losses).NOTE: The PE10 tubing should be long enough so that the air bubble does not enter the plastic cuff of the glass syringe when loading the tracer. For a typical experiment, the protocol uses 10 μL of bovine serum albumin conjugated to Alexa Fluor 647 (BSA-647) diluted in aCSF at 0.5%.
	Confirm that the head plate fits into the head holder and that it is the right size for the mouse being used. Anatomical markers to ensure this are: the top border of the window aligns with the interocular line and the posterior border falls rostral to the occipital crest.NOTE: Stainless-steel head plates can be sterilized and reused. Most cyanoacrylate mixtures can be removed with an acetone solution.

	Surgical procedure
	Weigh and anesthetize the mouse (e.g. ketamine/xylazine; 100 mg/kg ketamine, 10 mg/kg xylazine; i.p.).
	Once the mouse no longer responds to a toe pinch, moisten the neck and head with sterile water and shave using clippers. Once the area is shaved, wipe the area with an alcohol swab again to remove any residual hair.NOTE: Moistening the fur before clipping dramatically reduces the amount of hair in the imaging window after the incision.
	Place the mouse in a stereotactic frame on top of a temperature-controlled pad and apply petroleum ophthalmic ointment to the mouse’s eyes to ensure they do not dry out.
	Clean the exposed skin with a chlorhexidine swab. After 2 min, remove the chlorhexidine with an alcohol wipe. Finally, apply an iodine solution which can be left to dry.
	Apply topical analgesia (0.25% Bupivacaine HCl) to the top of the skull and the neck.
	Starting on the part of the neck that covers the occipital crest, make a midline cut in the overlying skin and continue rostrally towards the interorbital line. Incise laterally to the border where the temporal muscle inserts into the skull. Remove all of the skin of the fusiform incision to expose both the frontal and parietal bones.CAUTION: The retroorbital sinus lies caudal to the eyes and large branches of the posterior facial vein lie rostral to the pinna. Be careful when making the incision to spare these structures. If this occurs, stop bleeding by maintaining hemostasis with a sterile cotton swab for several minutes and continue.
	Irrigate the skull with sterile saline and clean the surface using cotton swabs so that it is free of debris and hair since these will interfere with the image quality. Skull transparency is best preserved by leaving the periosteum and overlying fascia intact.NOTE: If these structures are accidentally removed, the skull can become dry and opaque over time. Re-moisten with aCSF or use a mixture of paraffin oil and glycerol to reduce skull reflectance in acute experiments21.
	Proceed to inserting the cisterna magna cannula - for surgical details of this procedure, refer to Xavier et al9.
	After inserting the CM cannula, apply a mixture of dental cement with cyanoacrylate glue to the ventral side of the head plate around the border and place it on the skull so that the anterior border of the head plate aligns with the posterior tip of the nasal bone and the posterior border aligns with the anterior aspect of the interparietal bone, making sure that the sagittal suture (midline) is centered and straight relative to the window (Figure 1B).
	Fix the position of the head plate using a couple drops of glue accelerator. Fill any remaining gaps with the cement mixture and cure it with accelerator.CAUTION: Make sure the cyanoacrylate does not come in contact with the mouse’s eyes or block the imaging window.
	Glue the CM cannula to the head plate to ensure that these do not become detached during transport or when the mouse wakes up.
	For acute experiments, skip to Step 2.16.
	For chronic experiments, apply a thin layer of clear-drying cyanoacrylate glue to the exposed skull, being careful not to create bubbles as these will interfere with the imaging. The glue provides protection for the skull and will not interfere with the imaging. Make sure that the glue covers the exposed skull all the way to the skin at the incision border.
	Use a hemostat clamp to hold the aCSF-filled PE10 tubing 2–3 cm from the CM and cut the line with a high-temperature cautery tip. Once it is separated, flatten the melted PE10 tubing to seal the cannula.CAUTION: Make sure not to release the clamp until after the cannula has been sealed and confirm there are no leaks in the tubing to prevent a CSF fistula.
	Administer carprofen (5 mg/kg every 24 h for 3 days; i.p. or s.c.) and return the mouse to a temperature-controlled, single-housed cage and allow it to recover for at least 24 h prior to imaging. Do not leave the mouse unattended until it regains sufficient consciousness to maintain sternal recumbency. Intact cranial windows remain stable for several weeks.NOTE: The chronic experiment can be paused here.CAUTION: Some postoperative complications are: cephalohematoma/subgaleal hematomas, CSF fistula, and infection.
	For acute experiments, place the mouse into the head holder using the head plate so the skull is in a fixed position. Make sure to check anesthesia level and place a heating pad under the mouse. The mouse is now ready to be taken to the macroscope.CAUTION: Carefully transport the mouse together with the infusion pump on a cart. If the CM cannulation becomes dislodged, it will cause a drop in intracranial pressure and any CSF leaks will alter the experimental results.

	Preparing the mouse for imaging
	Anesthetized MicePlace the head holder on the stage of the macroscope, making sure there are no kinks in the line from the syringe pump to the CM cannula and that it is not taut since this could affect the tracer infusion.Observe respiratory rate and pink coloration of the mucous membranes, indicating good oxygenation. Inject saline subcutaneously to secure hydration level if necessary. Check to make sure the animal is sufficiently anesthetized and re-dose if needed.Turn on the macroscope camera and LED and start LIVE mode.Confirm the magnification of the imaging field so that the nasofrontal suture at the top of the field and the lambdoid suture at the bottom can clearly be visualized, with the sagittal suture parallel and centered to the middle of the image (Figure 1C). Once in place, secure the head holder to the macroscope stage with tape.Focus the macroscope on the exposed skull. Despite macroscopes having a relatively large depth of field, the curvature of the mouse’s skull only allows for a specific area to be in focus. Best results are obtained when the focal plane is located on the lateral sides of the parietal bones posterior to the coronal sutures.NOTE: This is the location of the middle cerebral arteries (MCA), where most CSF inflow occurs (Figure 1D,E)10.
	Place the head holder on the stage of the macroscope, making sure there are no kinks in the line from the syringe pump to the CM cannula and that it is not taut since this could affect the tracer infusion.
	Observe respiratory rate and pink coloration of the mucous membranes, indicating good oxygenation. Inject saline subcutaneously to secure hydration level if necessary. Check to make sure the animal is sufficiently anesthetized and re-dose if needed.
	Turn on the macroscope camera and LED and start LIVE mode.
	Confirm the magnification of the imaging field so that the nasofrontal suture at the top of the field and the lambdoid suture at the bottom can clearly be visualized, with the sagittal suture parallel and centered to the middle of the image (Figure 1C). Once in place, secure the head holder to the macroscope stage with tape.
	Focus the macroscope on the exposed skull. Despite macroscopes having a relatively large depth of field, the curvature of the mouse’s skull only allows for a specific area to be in focus. Best results are obtained when the focal plane is located on the lateral sides of the parietal bones posterior to the coronal sutures.NOTE: This is the location of the middle cerebral arteries (MCA), where most CSF inflow occurs (Figure 1D,E)10.

	Awake MicePrior to the imaging session, let the animals recover for at least 24 h from the head plate surgery. Longer recovery periods (5–7 days) are also recommended. During this time, train the mouse to be head fixed on the stage in the restraint tube for 0.5–1 h per day for the duration of the recovery period.NOTE: Habituation allows the mouse to be attached to the head holder without anesthesia and reduces stress and anxiety during the actual experiment. If this is not feasible and anesthesia does not interfere with the experiment, an induction dose of an inhaled anesthetic (e.g., isoflurane 2% at 1–2 L/min O2 flow rate) can be used to quickly attach the mouse to the head stage.Once the mouse is fixed to the head holder and in the restraint tube, follow Steps 3.1.1–3.1.5.
	Prior to the imaging session, let the animals recover for at least 24 h from the head plate surgery. Longer recovery periods (5–7 days) are also recommended. During this time, train the mouse to be head fixed on the stage in the restraint tube for 0.5–1 h per day for the duration of the recovery period.NOTE: Habituation allows the mouse to be attached to the head holder without anesthesia and reduces stress and anxiety during the actual experiment. If this is not feasible and anesthesia does not interfere with the experiment, an induction dose of an inhaled anesthetic (e.g., isoflurane 2% at 1–2 L/min O2 flow rate) can be used to quickly attach the mouse to the head stage.
	Once the mouse is fixed to the head holder and in the restraint tube, follow Steps 3.1.1–3.1.5.


	Infusion of fluorescent CSF tracers
	Acute CM Cannulation
	Since the tracer was already loaded into the cannula before being placed in the cisterna magna in Step 1.6, set the infusion pump to the desired rate and volume. Infusion paradigms routinely used are 5–10 μL at 1–2 μL/min, but these parameters can be adjusted depending on the particular experiment, or the size and age of the animal.

	Chronic CM Cannulation
	Prior to beginning the imaging session, follow Steps 1.2–1.7 for acute experiments to prepare the infusion line to deliver the tracers.
	Once the line is prepared, using a hemostat clamp cut the sealed end of the chronic CM cannula. Take the needle from the line prepared in Step 4.2.1 and gently insert it into the cannula. Release the clamp and using the syringe pump, advance the CSF tracer at the desired infusion rate (e.g., 2 μL/min) for the experiment until the tracer reaches the implanted needle in the CM.CAUTION: If the needle pierces through the tubing when connecting the line, remove the needle, cut the pierced segment and repeat this step. Any tear in the PE10 tubing will cause a leak and affect the results of the experiment.


	Setting up the Imaging Session
	Based on the fluorescent tracer being infused, determine the excitation wavelength and the exposure time for each channel. Choose the shortest exposure time necessary to visualize the tracer in order to maximize the temporal resolution of the time-lapse imaging. This exposure time will be used for all subsequent experiments aiming to compare CSF transport between different animals.NOTE: One tip is to use the tracer in the CM line to adjust the exposure time. Although this is a useful first approach, this should be optimized over time.
	Choose the duration of the experiment and the intervals at which the images will be acquired. Experiments normally last between 30–60 min depending on what phase of glymphatic transport is of interest. Frame rates of 1 frame/min and faster are sufficient for most experiments.
	Set the file name and the saving directory.
	If the imaging will be collected in addition to simultaneous acquisition of other variables (e.g., electrocardiogram, arterial blood pressure, electrophysiology), the macroscope and pump can be programmed to be triggered with the data acquisition software. Check that the triggering function on the macroscope is correct before moving to the next step.

	Transcranial optical imaging experiment
	Start the tracer infusion and the imaging at the same time.
	Routinely check the CM cannula and the PE10 tubing for any signs of a leak. If there is any tracer leaking at the CM, the results from this experiment must be excluded.NOTE: If tracer starts to accumulate in the cerebellum and does not travel the glymphatic pathway of the MCA, it is likely that the CM cannula was injected into the cerebellum. This data should not be included.
	For acute experiments, after completion of the experiment, remove the mouse from the microscope and check that it is still adequately anesthetized. Quickly decapitate the mouse and harvest the brain tissue. Immersion-fix the brain in 4% paraformaldehyde (PFA) overnight at 4 °C.For chronic experiments, once the imaging is completed, remove the CM line from the cannula, flush with sterile aCSF and reseal the CM cannula with a high-temperature cautery tip. Remove the mouse from the head stand and return it to its cage. Repeat this process until further imaging is not required and then follow Step 6.3.
	For chronic experiments, once the imaging is completed, remove the CM line from the cannula, flush with sterile aCSF and reseal the CM cannula with a high-temperature cautery tip. Remove the mouse from the head stand and return it to its cage. Repeat this process until further imaging is not required and then follow Step 6.3.


	Data analysis
	Import the image stacks into Fiji using the Bio-Formats import tool. This function will preserve the file metadata which includes the time and pixel resolution. Save the image stack as a .tiff file.
	Manually draw a region of interest (ROI) around the skull or the area of interest using the polygon selection tool. For example, in Figure 1G an ROI was drawn separately for the ipsilateral and for the contralateral hemisphere after a traumatic brain injury. Make sure to add the ROI into the ROI Manager (Analyze>Tools>ROI Manager) and save it.NOTE: CSF transport can be quantified in two main ways: 1) mean fluorescence intensity over time or 2) influx area expressed as a percentage of the ROI or total area (mm2) after having applied a threshold. The latter method (Figure 1H) will be described in the next steps.
	Set the threshold on the frame with maximal fluorescence (Select Image>Adjust>Threshold…). Automated threshold methods such as Otsu are normally good at detecting CSF tracer. Apply the threshold.
	Before going forward, make sure that in Analyze>Set Measurements, the options Area and Area Fraction are selected. Then in the ROI Manager, select More>Multi Measure.
	Convert the %Area value into mm2 using the Area value of the ROI from the output. The %Area values reflect the percent of the dorsal cortical surface with CSF tracer.
	Plot CSF tracer influx in mm2 as a function of time.
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